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1 Software Installation

1.1 Software Installation

Requirements of Software Operating Environment

To better use Kompass RX6, the computer where Kompass RX6 is installed needs to meet the minimum
configurations for the operating environment as follows:

 CPU: 9th Generation Intel® Core™ i7 or later

 RAM: 16GB or greater DDR4 2666

 Graphics card: NVIDIA P2200 (or later) or AMD W5100 (or later) discrete graphics card recommended

 HD space: 512G or larger SSD

 OS: Windows 10 Pro (64-bit)

Installation Procedure

Step 1 Double click the program file (Kompass RX6.exe) to start the installation wizard.

Step 2 Click Browse to select the folder where the software will be installed.

Figure 1-1 Select installation path

Step 3 Click Next to enter the Select Start Menu Folder page.
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Figure 1-2 Select start menu folder

Step 4 Click Browse or enter the folder name directly to select a folder for the start menu.

Step 5 Click Next to enter the Select Additional Tasks page,

Check the box next to Create a desktop shortcut to add the Kompass RX6 shortcut icon on the desktop.

Figure 1-3 Additional tasks

Step 6 Click Next to enter the Ready to Install page.
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Figure 1-4 Installation confirmation

Step 7 Click Install to enter the automatic installation page.

Figure 1-5 Automatic installation

Step 8 After the software installation is finished, click Finish.

The system will exit the software setup page and start the Kompass RX6 software automatically.XI'
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Figure 1-6 Installation completed

After the program is successfully installed, two programs (Kompass RX6 and NDI Sender RX6) appear on
your desktop.

 Kompass RX6: Video playback and control program

 NDI Sender RX6: NDI sender that provides NDI inputs for Kompass RX6

Notes

 It is recommended you turn off the anti-virus software and firewall in advance.

 If any security alert from anti- or firewall appears during installation, choose to allow the installation.

 If the software prompts you to restart after the installation, it is recommended you restart the software in
time.

1.2 Software Licensing

After Kompass RX6 is started, the software automatically detects the presence of an authorization dongle. If a
dongle is detected, the Kompass RX6 user interface will be displayed normally; if not, the following window will
be displayed and guide you through obtaining the authorization dongle.
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Figure 1-7 Dongle detection

You can license your software via the following two methods.

 Purchase an authorization dongle from your sales.

1. Insert the authorization dongle into the USB connector of the computer, and start the Kompass RX6
software.

2. Copy the authorization ID file in the USB drive that comes with the authorization dongle to your computer.

3. On the authorization user interface, click Import at the upper right corner and select the authorization ID
file.

4. Click Open to complete the importing.

 Take a clear picture of the QR code and send it to your sales to obtain the registration code. Enter the
obtained registration code in the text box below the QR code, and click to complete the authorization.
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2 Applications

Figure 2-1 Kompass RX6 applications
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3 User Interface Introduction
After the software is started successfully, the main user interface is shown in Figure 3-1. The functions of each
area are described in Table 3-1.

Figure 3-1 User interface

Table 3-1 User interface descriptions

Area Item Description

Menu bar File Project file operations include:
 New: Create a new project.
 Open: Open a saved project.
 Save: Save the current project.
 Save As: Save the current project as a new project.
 Package Project: Package the current project and the media files in
it as an independent project file for easy use in future.

Resource Manage the media files and input sources.
 Add Local Media: Add the local media files.
 Add Input Source: Add the network media, NDI screens and
websites as input sources.

 Delete All Media: Delete all the imported media files.
 Delete All Inputs: Delete all the added input sources.

Output Manage the screens and pasters.

Window Show or hide the areas of the Kompass RX6 user interface. The area
options include Media Library, Editing Area, Output, Preview, Fade
to Black and Plan.

Online  Disconnect Primary: When a backup device is added, use this
function to disconnect the binding relation between the primary and
backup devices.

 Synchronize Data: Manually synchronize the data on the primary
and backup devices, and the data on the master and slave devices.

Settings Perform the system settings, authorization and hotkey bindings.

Help  View the user manual.
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Area Item Description
 View the product-related information.
 Check for the software updates.
 Get the contact of the product provider.

语 言
/Language

Switch the UI language.

Preview area  Output: View the content of the current output program.
 Preview: Preview the content of the next program.

− Cut: Send the currently previewed program to the screen and play it from the
beginning.

− Keep: Send the currently previewed program to the screen and start playing
from the current progress in the preview area.

 : View the output image, and adjust the output paster position.

 : View all the pasters.

 : View all the layers.

Editing area  Use layers to configure the output according to the on-site screen pattern.
 Preview the output image.

 : After selecting a layer or paster in the editing area, click this icon to capture the
current frame of the selected layer or paster and add the captured image to the
media library.

 : When the output image is moved out of the visible area, click this icon to
restore the screen to the origin.

 : Zoom in the editing area.

 : Zoom out the editing area.
When the Output and Preview areas are both in the Paster or Layer mode, you can
set whether to sync the displays in those two areas

 : The paster or layer editing in the Output and Preview areas are in sync.

 : The paster or layer editing in the Output and Preview areas are independent,
not in sync.

Layer and
program editing
area

 Add, control and mosaic the layers.
 Edit, group and play the layers.

Playback control
area

Control the playback of the programs or layers in the program.

Media library and
properties area

Media
Library

Manage the media files.
 Add the local media files.
 Create folders to manage the media files efficiently.
 Delete, replace or rename the media file.

Input
Sources

Manage the input sources.
 Add the network media, NDI screens and websites as input
sources.

 Delete the input sources.
 Preview the input sources.

Properties Edit the layer or program properties.

Enable or disable the U3 control.
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3.1 Change UI Layout
Kompass RX6 allows you to adjust the user interface layout according to your using habits. You can save and
load the adjusted layout.

Step 1 Move the cursor to any edge of an area. When the cursor turns into a double-sided arrow, click and drag the
mouse to change the area size.

Step 2 Move the cursor to the title bar of an area, and click and drag the mouse to change the area position.

Step 3 Click at the top right of the user interface to save the adjusted layout.

Figure 3-2 Save layout

Step 4 Enter a layout name.

The layout name is unique and it is recommended you set a name that is easy to recognize.

Step 5 Click Save to save the layout.

3.2 Load Layout

When the interface layout has been adjusted by others, you can load your preferred layout simply by using
this function, instead of adjusting it area by area.

Step 1 Click at the top right of the user interface to open the layout loading window.

Figure 3-3 Load layout

Step 2 Select the desired layout from the list on the left.

Step 3 Click Load to load the layout.

You can also perform the following operations:

 Delete: Delete the selected layout from the layout list.

 Restore Default: Restore the current interface layout to the default style.
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 Cancel: Cancel the layout loading and exit the layout loading interface.

3.3 Lock User Interface

If you do not want others to operate the software when you are away, just simply use this function to lock the
software interface.

Step 1 Click at the top right of the user interface to open the UI locking window.

Figure 3-4 Lock user interface

Step 2 Enter a password.

Step 3 Set the opacity for the locking interface.

100% is completely opaque. At this time, the editing interface is completely invisible and only the lock screen
background can be seen.

Step 4 [Optional] Click Change next to Background to select a picture to be displayed on the locking interface.

Step 5 Click Lock to complete the locking settings and lock the interface.

Notes
 The locking password and background are for one-time use only. When you want to lock the interface

for a second time, please set the password and background again.

 To unlock the user interface, just enter your password click to show the Kompass RX6 interface.

3.4 Change Output/Preview Mode

The editing area can be set to the following three modes.

 Output: View and adjust the pasters on the output.

Click at the top right of the Output or Preview area, and the editing area enters the Output-Screen
mode. You can adjust the sizes and positions of the pasters to change the output display.

 Paster: View all the pasters and simulate the on-site environment using the pasters.

Click at the top right of the Output or Preview area, and the editing area enters the Output-Paster
mode. You can adjust the sizes and positions of the pasters to simulate the on-site application environment.

− In this mode, after you have changed the paster size according to the actual screen size in the field,
you can simply change the paster position in the Screen mode.

− In this mode, changing the paster position will not affect the paster position in the Screen mode.

− This mode is only used for adjusting the paster size in advance, not for the output adjustment.

 Layer: View all the layers.

Click at the top right of the Output or Preview area, and the editing area enters the Output-Layer
mode. You can all the layer images in the playback programs.
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− Click at the top right of the Output area, and you can view all the media in the layers of the
current program.

− Click at the top right of the Output area, and you can view all the media in the layers of the next
program.

4 Project
Kompass RX6 allows you to add media files, edit the programs, set the program playback sequence and
media properties, and more. After all these are done, you can save the project as an independent project file
to your local storage for future use.

4.1 Create New Projects

There are three methods provided for you to create a new project.

 After Kompass RX6 is started successfully, click New on the startup interface and select the save path for
the new project, and finally click Save. The system will automatically create a project file.

 Go to File > New, select the save path for the new project and click Save to create a new project.

 Click below the menu bar to create a new project.

4.2 Manage Media

Kompass RX6 supports pictures, videos, audio media files and website inputs.
The supported media formats are as follows:

 Video: mp4, avi, mkv, flv, mov, mpeg, mpg, ts, wmv, 3gp

 Picture: jpg, jpeg, bmp, png, gif, ico

 Audio: mp3, aac, flac, amr, ape, wav, wma, ogg

4.2.1 Add Media

Kompass RX6 supports both single media file importing and batch importing.

4.2.1.1 Import Files

Step 1 Click the Media Library tab on the right pane of the user interface.

Step 2 Right click the blank area in the Media Library area and select Add Local Media to open a local folder.

Step 3 Select the target media files and click Open. Kompass RX6 will import the selected files to the media library
automatically.

 Importing a single file: Select the desired file and click Open to complete the importing.

 Importing multiple files: Press the Shift/Ctrl key, select the desired files, and click Open to complete the
importing.

4.2.1.2 Import Folders

There are three methods provided for you to import a folder.

 Import folder

Step 1 Right click the blank area in the Media Library area and select Add Local Folder to open a local folder.

Step 2 Select the desired folder where the media files are stored, and click Open.

The system will automatically import the media files in the target folder with their original names to the media
library.

 Replace folder
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Step 1 Right click the blank area in the Media Library area and select Add Folder. The system will automatically
create a new folder.

Step 2 Right click the folder and select Replace in the context menu.

Step 3 Select the desired folder from the displayed dialog box.

Step 4 Click Select Folder and the system will automatically import the media files in the target folder with their
original names to the media library.

4.2.2 Edit Media

4.2.2.1 Media Optimization

When the imported media or video resolutions are inconsistent, to facilitate future use, you can change the file
resolution in advance by using this function.

Note

Only the videos and .jpg pictures can be optimized to even resolutions only.

Step 1 Select the picture or video that needs to be optimized from Media Library.

Step 2 Right click the file and select Media Optimization in the context menu.

Step 3 Set the desired parameters for the optimization.

Figure 4-1 Media optimization

Step 4 Click Optimize and the system will automatically optimize the selected media file.

4.2.2.2 Create Playback Collection

The playback collection allows you to sort and combine multiple videos or pictures into a new collection source.
All the videos and pictures in the collection will be played automatically according to the set mode.

Step 1 Right click the blank area in the Media Library area and select Create Collection to open the Create
Collection window.
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Figure 4-2 Playback collection

Step 2 Select the desired media files in the All Media area on the left side.

Step 3 Click at the top right in the All Media area to add the selected files to the Collection Media area on
the right side.

Step 4 Select the newly-added media in the Collection Media area.

Step 5 Change the media properties at the bottom.

Table 4-1 Collection media properties

Property Description

Duration Set how long the selected media will be played. After the playback ends, the
next media will be played automatically.
If the duration is not set, the video file will be played according to its original
playback duration, and the picture file will be played for 10 minutes by default.

Times Set how many times the selected media will be played.

Playback Set the media playing order in the collection media.
 Sequential: The media in the collection will be played in sequence.
 Shuffle: The media in the collection will be played randomly.

Set image duration only Set the playback duration for only the picture files in the collection.

Display proportionally If this option is selected, the media file will be displayed according to its original
ratio. Otherwise, it will fill the layer.

Enable PIP If this option is selected, the media file will have a PIP image of its original ratio.

Switching Set the transition effect when the current media starts to play or stops the
playing. Currently, only Cut and Fade effects are supported.

Fade in Set the time length from when the current media starts to play to when the media
is fully displayed.

Fade out Set the time length from when the current media starts to stop to when the
media is stopped.

Step 6 Repeat Step 2 to Step 5 to complete the settings of other media in the collection.
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Step 7 Click OK to complete the collection settings.

Step 8 Double click the collection name, and the name becomes editable. Rename the collection and press Enter to
confirm the change.

After a collection is created, the default name is Playback Collection. It is recommended you give it a new
name that is easier for you to distinguish.

4.2.2.3 Media File Group Management

You can create folders to classify the added media files.

Step 1 Right click the blank area in the Media Library area and select Add Folder. The system will automatically
create a new folder.

Step 2 (Optional) Double click the folder to rename it.

Step 3 Select the desired media files and drag them to the new folder.

Notes
 Hold down the Shift or Ctrl key, and select the target file or multiple files in Media Library.
 After selecting a media file, right click it and select Insert Folder in the context menu to move the

selected file to the newly-inserted folder.

4.2.2.4 Media File Context Menu

Right click a media to show the media file context menu.

Figure 4-3 Media file context menu

 Add Local Media: Add new media files into the media library.

 Media Optimization: Change the coding, quality, code rate, frame rate, audio and resolution settings of the
videos or pictures.

Only the videos and .jpg pictures can be optimized to even resolutions only.

 Create Collection: Create a collection media.

 Change Playback Collection: Change the settings of the collection media.

 Add Local Folder: Import a folder containing media files into the media library.

 Insert Folder: Create a new folder and move the selected media files into the folder.

 Rename: Rename the selected media or collection.

XI'
AN
 N
OV
AS
TA
R T
EC
H 
CO
., L
TD
.



Kompass RX6 Video Playback and
Control Software User Manual

www.novastar.tech 15

 Replace Media: Replace the currently-selected media. When the media is replaced, the media in the
program will also be replaced synchronously.

 Access File Location: Open the storage location of the current media.

 Delete: Delete the current media.

 Properties: View the media properties, such as the name, size, format and more.

4.2.3 Add Input Sources

You can add the website input sources, NDI input sources and input sources from acquisition devices. The
system automatically identifies and adds the input sources from acquisition devices. You can also enable or
disable the acquisition device.

Note
When the acquisition card and its driver have been installed into the device successfully, Kompass RX6 will
automatically identify and add the acquisition card input source.

4.2.3.1 Add Website Input Sources

Step 1 Click the Input Sources tab on the right pane of the user interface.

Step 2 Right click the blank area and go to Add Input Source > Add Website. The website page will appear as
shown below.

Figure 4-4 Add website input sources-1

Step 3 Enter an URL in the address bar.

Step 4 Press Enter to enter the website and select the content to be played.

Step 5 Click × at the top right to close and finish adding the website.

Note

When multiple tabs are opened, the input source displays the tab you stay on before closing.
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Figure 4-5 Add website input sources-2

 1: Preview window where you can preview the input source image, input source name, type and resolution

 2: List all the input sources with their names.

4.2.3.2 Add NDI Input Sources

After Kompass RX6 is successfully installed, the NDI configuration tool NDI Sender that comes with Kompass
RX6 will be installed. After NDI Sender is enabled, Kompass RX6 will automatically search for all the
computers whose NDI sending functions have been enabled in the current network segment.

Prerequisites

 The computer running the NDI Sender and Kompass RX6 must be on the same network segment.

 Make sure the computer running the NDI Sender and Kompass RX6 can communicate normally.

NDI Settings

Step 1 Double click the NDI Sender shortcut on the desktop to open the NDI Sender software.

Figure 4-6 NDI Sender

Step 2 Set the image position and size for NDI on the computer screen.

There are two methods to set the NDI image position and size.

 Click Select ROI and then click and drag the mouse to select the display area you want to send.
 In the Sent ROI area, you can precisely set the position and size of the sent area.

− x: The horizontal offset from the top left corner of the sent area to the screen’s left edge

− y: The horizontal offset from the top left corner of the sent area to the screen’s top edge

− w: The horizontal width of the sent area

− h: The vertical height of the sent area

After the settings, you can click Show ROI to see the image position and image size you have set.
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Step 3 Enter an NDI name.

Step 4 Select the screen you want to send if there are multiple computer screens.

Step 5 Enter the frame rate of the NDI image. The default value is 25.

Step 6 Click Start to complete the NDI Sender settings.

Add NDI Input Sources

Step 1 Click the Input Sources tab on the right pane of the user interface.

Step 2 Right click the blank area and go to Add Input Source > Add NDI Input. The system will automatically search
the current network segment for all the NDI-enabled devices and then show you the NDI list.

Figure 4-7 NDI list

Step 3 Select the NDI sources from the NDI list.

Figure 4-8 Select NDI sources

Step 4 Enter an NDI name.

After the name is changed here, the new name will be displayed under the Input Sources tab.

Step 5 Click OK to complete adding an NDI source.

Website Input Source Menu

Right click an input source under the Input Sources tab to show the website input source menu.
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Figure 4-9 Website input source menu

 Add Input Source: Add a new website or NDI input source.

 Rename: Change the input source name.

 Set Loop Interval: Set how long the input source is previewed in the preview area.

 Preview: Preview the currently-selected input source in the preview area. Only the current input source is
previewed, and no loop preview is performed.

 Restore Loop Preview: Perform loop preview of all the input sources in the preview area.

 Delete: Delete the current input source.

 Properties: View the relevant information of the input source, including the name, type, network address,
resolution and frame rate.

 Enable Acquisition Card: Kompass RX6 automatically identifies and adds the sources from the acquisition
device. The acquisition card is enabled by default.

 Disable Acquisition Card: Disable the acquisition card.

4.3 Manage Layers

4.3.1 Add Layers

The layer is a container where you store the media file of a program. Before you edit the program, please add
the layers and add the media files into the layers first.

Step 1 Click + at the top left in the Plan area to add a layer.

The new layer will be added to each program.

Step 2 Click at the top right in the Output area, and the editing area displays all the layers.

Step 3 Change the layer position in the Editing Area (Output-Layer) to arrange the layers and avoid overlapping
perfectly.
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Figure 4-10 Layer position

Step 4 Select a layer and click the Properties tab on the right pane to show the layer properties.

Step 5 Configure the layer-related properties by referring to Table 4-2.

Note

When you click and drag the layer, the purple auxiliary lines appear to help you better align the layers.

4.3.2 Layer Mosaic

Applications

When an image needs to be output by multiple connectors and pixel-to-pixel display is required, you can use
this function to satisfy your needs.

Figure 4-11 Layer mosaic effect

Operating Procedure

Step 1 Click at the top left in the Plan area to open the layer mosaic window.

XI'
AN
 N
OV
AS
TA
R T
EC
H 
CO
., L
TD
.



Kompass RX6 Video Playback and
Control Software User Manual

www.novastar.tech 20

Figure 4-12 Layer mosaic-1

Step 2 Select and drag the layers in the Layer Layout area to the Layer Mosaic Layout area.

Figure 4-13 Layer mosaic-2

Step 3 Arrange the layers in the way you prefer in the Layer Mosaic Layout area.XI'
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Figure 4-14 Layer mosaic layout

Step 4 (Optional) Change the mosaic layer name in the Properties area on the right.

Step 5 Click Save to complete the layer mosaic.

After the mosaic is completed, a new mosaic layer will be displayed in the Plan area.

4.3.3 Set Layer Properties

Layer Menu

Right click a layer in the Plan area to show the layer menu as shown below.

Figure 4-15 Layer menu

 Rename: Change the layer name.

 Close Image: Do not display the image of the current layer in all the programs.

 Close Audio: Do not play the audio of the current layer in all the programs.

 Lock layer: Lock the current layer in all the programs. After the layer is locked, the layer property changes
will not take effect.

 Forward/Backward: Adjust the order of the layer.

 Insert Above: Insert a layer above the current layer row.
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 Insert Below: Insert a layer below the current layer row.

 Clear Layer: Clear the data in the current layer.

 Delete Layer: Clear the layer data and delete the layer.

Layer Properties

Step 1 Select a layer in the Plan area or Editing Area.

Step 2 Select the Properties tab on the right pane of the user interface.

Figure 4-16 Layer properties

Table 4-2 Function descriptions

Function Description

Name View and change the layer name.

Control  Close Image: Do not display the image of the current layer, and only the audio is
played.

 Close Audio: Do not play the audio of the current layer, and only the image is
played.

 Volume: Adjust the output volume of the current layer. The default value is 100%.

Click to reset the volume to default.

Flip Set the flipping mode of the output image. If H and V are not selected, the output
image is displayed normally, without any flipping effect.
 H: Flip the image horizontally.
 V: Flip the image vertically.

Position Set the layer's position in the editing area, i.e., the distance from the top left corner
of the layer to the top left corner of the editing area. The unit is the pixel.
 X: Set the horizontal distance between the top left corner of the layer and the top
left corner of the editing area.

 Y: Set the vertical distance between the top left corner of the layer and the top left
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Function Description
corner of the editing area.

Size Adjust the layer size. The unit is the pixel.
 W: Set the layer size in the horizontal direction.
 H: Set the layer size in the vertical direction.

Priority Adjust the layer display order.
 U: Bring the selected layer forward.
 D: Send the selected layer backward.
 T: Bring the selected layer to the top.
 B: Send the selected layer to the bottom.

Filling Set how the image is displayed in the selected layer.
 Fill: The image fills the whole layer.
 Proportional: The image is scaled and displayed in the layer according to its
original aspect ratio.

Bright Set the overall brightness of the layer image. The value range is 0%–100%, and it
defaults to 50%.

Contrast Set the overall contrast of the layer image. The value range is 0%–100%, and it
defaults to 50%.

Opacity Adjust the transparency of the output image. The value range is 0% (totally
transparent)–100% (opaque), and it defaults to 100%.

Hue Set the relative degree of how bright or dark the output image is. The value range is
0%–100%, and it defaults to 50%.

Saturation Adjust the colorfulness of the output image. The value range is 0%–100%, and it
defaults to 50%.

Feathering Adjust the blurring degree of the layer image edges. The value range is 0% (not
blurred)–100% (totally blurred), and it defaults to 0%.

Insert Above Insert a layer below the current layer row.

Insert Below Insert a layer below the current layer row.

Delete Layer Clear the layer data and delete the layer.

Clear Layer Clear the data in the current layer.

4.4 Build Application Environment

In Kompass RX6, you can use the screens and pasters to build an application environment according to your
actual on-site needs.

 Screen: Configure the output image displayed on the screen.

 Paster: Configure the image output by the corresponding output connector.

Click Output in the menu bar to open the Output Management window where you can relate the screens
with the output connectors and change the screen position and sequence.
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Figure 4-17 Output management

4.4.1 Add Screens

Each output connector on the discrete graphics card of the computer or server where Kompass RX6 is
installed corresponds to a screen.

Add and Bind Screens Automatically

Kompass RX6 will automatically detect the graphics card connectors and then complete the adding and
binding of those detected connectors. All the connectors are displayed in the output list on the left.

Add and Bind Screens Manually

When you add the graphics card to the control PC or change the saved project file, you can add the screens
manually.

Step 1 Click Add Screen at the top left to add an output.

Step 2 Set the screen position and size according to the screen layout in the Screen Properties area on the right.
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Figure 4-18 Screen management

Table 4-3 Screen properties

Menu Description

Name Change the screen name.

Binding Set the relationship between the output connector and screen.

Position  X: Set the horizontal distance between the top left corner of the screen and the
top left corner of the screen editing area.

 Y: Set the vertical distance between the top left corner of the screen and the top
left corner of the screen editing area.

Size Set the screen size.
 W: Set the screen size in the horizontal direction.
 H: Set the screen size in the vertical direction.

Layout When there are multiple screens, use this function to arrange the screens quickly.

 : All the screens are arranged in a 1×4 pattern.

 : The screens are arranged in a 2×2 pattern.

 : All the screens are arranged in a 4×1 pattern.

Enable Mark Display a sequence number on the output connector and screen, which helps you
easily identify and adjust the output pattern.

Disable Mark Do not display the sequence number.

Disconnect Do not show the output image of the current screen.

Connect Show the output image of the current screen.

Step 3 Click and drag the screens to complete the screen mosaic.

4.4.2 Add Pasters

Kompass RX6 uses the pasters to output the image to the LED screen. Select the desired image area of the
layer using the paster, and then map the image to the output connector to complete the image construction.

Step 1 Click Output in the menu bar to open the Output Management window.

Step 2 Select the Paster tab.
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Figure 4-19 Screen paster and area descriptions

 Paster management: Add and delete pasters.

 Screen outputs and output pasters: Adjust the output paster positions on the screen to construct the
desired output image.

 Layers and layer pasters: Adjust the size of the layers and layer pasters, and adjust the position of the
layer pasters.

 Properties: Set the properties of the output pasters, layer pasters and layers.

 : Enable or disable the scale.

 : Restore the output paster or layer paster to the default size and position.

 : Restore the output screen or layer to the origin.

 : Maximize the Output | Paster or Layer | Paster area.

Step 3 Add the pasters.

1. In the paster management area, select the desired layer to add the pasters.

2. Click + next to the layer name to add a paster.

Note

You can also add the paters by simple copy and paste operations. Right click the desired layer or paster in
the Layer List area and then select Copy, and right click it again and then select Paste to add a layer or
paster.

Application Example

If you want to output only the tree in Layer B, do the following.
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Figure 4-20 Paster application example

Step 1 Under the Paster tab, select Paster B1 on the left side.

Step 2 In the Layer | Paster area, move the layer paster to cover the tree and adjust the paster size as needed.

Step 3 In the Output | Paster area, adjust the output paster size as needed and move the paster to the desired
screen.

After the settings, the screen display is shown as below.

4.4.3 Paster Properties

Output Paster

The output pasters are used for the construction of the output image. The output paster outputs the image of
the corresponding layer paster, and then scales the layer paster image according to the output paster size you
set. Select the desired output paster in the Output | Paster area, and then set the paster properties on the
right.
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Figure 4-21 Output paster properties

Table 4-4 Function descriptions

Area Parameter Description

Basic
properties

Name Display or change the name of the output paster.

Position View or set the output paster position in the Output | Paster area. The
origin of the Output | Paster area is the adjustment reference point and
the adjustment unit is the pixel.
 X: View or set the horizontal coordinate of the top left corner of the
output paster in the Output | Paster area.

 Y: View or set the vertical coordinate of the top left corner of the
output paster in the Output | Paster area.

Size Size: View or set the output paster size.
− W: View or set the output paster size in the horizontal direction.
− H: View or set the output paster size in the vertical direction.

Ratio Set the aspect ratio of the output paster.

Rotation Rotate the output image clockwise based on the center of the output
paster.

Flip Set whether to flip the image of the output paster.
 H: Flip the paster image horizontally.
 V: Flip the paster image vertically.

Opacity Adjust the transparent degree of the output paster. The value ranges
from 0% (totally transparent) to 100% (nontransparent).

R/G/B Adjust the RGB values of the output paster.

Priority View or set the displaying priority of the output paster.
 Display: Indicate the priority of the output paster by a number. The
larger the number, the higher the priority, i.e., the more front the
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Area Parameter Description
output paster is displayed.

 Adjustment: Select the desired output paster, and then click ,

, or to adjust its priority.

Irregular
paster
properties

Sync Set whether to sync the display of both the output pasters and layer
pasters. After disabling the sync function, you can set whether to output
the layer paster proportionally.
 Proportional checked: The output paster area displays the layer
paster image proportionally.

 Proportional unchecked: The layer paster image fills the output paster
area.

Shape Set the shape of the output paster. The default shape is the rectangle.
When Default is selected, the deform and form settings are
unavailable.

Deform In this mode, only the enclosing rectangle of the irregular paster can be
adjusted.

Form In this mode, you can drag the anchor points and adjust the curvature
to adjust the paster shape.
 Curve/Straight: Set the line type of the paster border.
 Color: Set the line color of the paster border.
 Stepping: Set the moving step of the anchor point.
For example, if the stepping value is set to 30, you can use the four
arrow buttons of your keyboard to move the selected anchor point by
30 pixels.

 Position: Set the positon of the anchor point upon the Output |
Paster area. The adjustment reference is the top left corner of the
output paster and the adjustment unit is pixel.

− X: Set the horizontal offset of the selected anchor point.
− Y: Set the vertical offset of the selected anchor point.

Note

In the Load area, enter your desired shape name and click Save to save the paster shape for easy use in
the future.

Layers

Select the desired layer in the Layer| Paster area, and then set the layer properties on the right.

Figure 4-22 Layer properties

 Name: Display or change the name of the layer.

 Position: View or set the layer position in the Layer | Paster area. The origin of the Layer | Paster area is
the adjustment reference point and the adjustment unit is the pixel.
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− X: View or set the horizontal coordinate of the top left corner of the layer in the Layer | Paster area.

− Y: View or set the vertical coordinate of the top left corner of the layer in the Layer | Paster area.
 Size: View or set the layer size.

− W: View or set the layer size in the horizontal direction.

− H: View or set the layer size in the vertical direction.

Layer Pasters

Select the desired layer paster in the Layer| Paster area, and then set the layer paster properties on the right.
The layer paster is used to select a specific image area of the layer image.

Figure 4-23 Layer paster properties

Table 4-5 Function descriptions

Area Parameter Description

Basic properties Name Display or change the name of the layer paster.

Position View or set the layer paster position upon the layer. The top left
corner of the layer is the adjustment reference point and the
adjustment unit is the pixel.
 X: View or set the horizontal coordinate of the top left corner of the
layer paster upon the layer.

 Y: View or set the vertical coordinate of the top left corner of the
layer paster upon the layer.

Size Size: View or set the layer paster size.
− W: View or set the layer paster size in the horizontal direction.
− H: View or set the layer paster size in the vertical direction.
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Area Parameter Description

Ratio Set the aspect ratio of the layer paster.

Rotation Rotate the layer paster image clockwise based on the center of the
paster.

Irregular paster
properties

Sync Set whether to sync the display of both the layer pasters and output
pasters.

Shape Set the shape of the layer paster. The default shape is the rectangle.
 When Default is selected, the deform and form settings are
unavailable.

 Except the default shape, other shapes of the layer pasters support
the invert function.

Deform In this mode, only the enclosing rectangle of the irregular paster can
be adjusted.

Form In this mode, you can drag the anchor points and adjust the curvature
to adjust the paster shape.
 Curve/Straight: Set the line type of the paster border.
 Color: Set the line color of the paster border.
 Stepping: Set the moving step of the anchor point.
For example, if the stepping value is set to 30, you can use the four
arrow buttons of your keyboard to move the selected anchor point
by 30 pixels.

 Position: Set the positon of the anchor point upon the Layer |
Paster area. The adjustment reference is the top left corner of the
layer paster and the adjustment unit is pixel.

− X: Set the horizontal offset of the selected anchor point.
− Y: Set the vertical offset of the selected anchor point.

Lock Display of Properties

By default, the properties of only one paster are displayed at a time. When you want to display the properties

of all the pasters and layers in the Properties area, click next to Output Paster, Layer Paster and
Layer to lock the display of the related properties.
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Figure 4-24 Lock properties

4.4.4 Add Backup Devices

Kompass RX6 supports the device backup to set the backup relationship between two devices. You can set
one of the devices as the primary device or the backup device. When the primary device has got a problem or
the primary device's cable fails, the backup device will take over the responsibilities of the primary device
seamlessly, and continue to work well to ensure the LED screen will not go black.

XI'
AN
 N
OV
AS
TA
R T
EC
H 
CO
., L
TD
.



Kompass RX6 Video Playback and
Control Software User Manual

www.novastar.tech 33

Figure 4-25 Application

Prerequisites

 The primary and backup devices must be on the same network segment.

 The primary and backup devices must be connected to the same downstream device, such as an F4 Lite
shown above.

Operating Procedure

Step 1 On the primary device, click Output in Kompass RX6 to open the Output Management window.

Step 2 Select the Screen tab and click Add Backup at the left.
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Figure 4-26 Add backup

Step 3 Go to Backup Properties on the right to configure the properties of the backup device.

 Name: Name the backup device.

 Bind IP: The system automatically searches for the IP addresses of the devices that have opened
Kompass RX6 on the current network segment. Select the IP address of the Kompass RX6 to be used as
a backup device from the drop-down list.

Step 4 Click Bind to complete the backup settings.

The primary and backup device data can be synchronized automatically, or you can also go to Online >
Synchronize Data to do the synchronization manually.

Figure 4-27 Backup list

Step 5 Click Unbind to remove the binding relation between the primary and backup devices.

You can also go to Online > Disconnect Primary to remove the binding relation.

4.5 Produce Programs

The playback unit of Kompass RX6 is the program.
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After you have completed the construction of the outputs and added images to the layers, the system will
output the image according to your construction (pasters).

4.5.1 Edit Programs

The system provides 50 programs by default. Before the playback of a program, you must add the media files
or input sources to the layers of the programs via either of the following two ways.

 Select the desired media file or input source in Media Library and drag it to the target program layer in the
Plan area.

 Select the desired media file or input source in Media Library and drag it to the target layer in the editing
area.

Figure 4-28 Edit programs

 The functions of the icons in the Plan area are described as follows.

: Return to the first program column.

 : Locate the program that is being played or edited.

 : Add a new program.

 : Turn off the image display of the selected layer.

 : Turn on the image display of the selected layer.

 : Turn off the audio of the selected layer.

 : Turn on the audio of the selected layer.

4.5.2 Set Media Continuation

When you want to play media content in the same layer of multiple continuous programs, you may need to
add the same media file to each program. The added media will be played from the beginning when a new
program starts, which may not be what you want to see. The cross-program media continuation function can
perfectly solve this problem. After you have enabled this function for a specified media, the program will be
played continuously but not played from the beginning when a new program is started.

Step 1 Right click the desired media in the Plan area and select Cross-P Media Continuation from the context
menu.
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Figure 4-29 Set media continuation

Step 2 Click and drag the media to the target program.

4.5.3 Set Program Properties

Program Menu

Right click a program to show the context menu as shown in the following, and you can set the program
properties as needed.

Figure 4-30 Set program properties

 Play: Play the current program.

 Map to Preview: Show the program content in the preview area.

 Rename: Change the program name.
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 Insert Before: Add a new program before the current program column.

 Insert After: Add a new program after the current program column.

 Delete Program: Clear all the layer data in the program and delete the program.

 Copy: Copy the current program and its properties.

 Paste: Paste the copied program and its properties to the specified program.

Program Properties

Step 1 Select a layer in the Plan area or Editing Area.

Step 2 Select the Properties tab on the right pane of the user interface to show the program property settings.

Figure 4-31 Program properties

 Name: View or change the program name.

 Status: Display the playback status of the current program.

 Switching: Set the transition effect when the program jumps.

 Bright: Set the brightness of the images in the program.

 Contrast: Set the contrast of the images in the program.

 Add Before: Add a new program before the current program.

 Add After: Add a new program after the current program.

 Delete Program: Clear all the layer data in the program and delete the program.

Media Context Menu in Program

Right click a media in a program in the Plan area to show the context menu.
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Figure 4-32 Media context menu

 Cross-P Media Continuation: When you want to play a media in the same layer of multiple continuous
programs, you may need to add the same media file to each program. The added media will be played
from the beginning when a new program starts, which may not be what you want to see. The cross-
program media continuation function can perfectly solve this problem. After you have enabled this function
for a specified media, the program will be played continuously but not played from the beginning when a
new program is started.

 Create Playback Collection: Open the Create Playback Collection window to create a collection and
perform the related settings.

 Rename: Change the name of the media in the program. The media name in the media library is changed
at the same time.

 Jump to Specified Program: Specify the desired program and the specified program will be played
automatically after the current program is completed.

 Paste: Paste the copied or cut media.

 Cut: Cut the media in the layer of the current program.

 Copy: Copy the media in the layer of the current program.

 Copy Properties: Copy the properties of the selected media.

 Paste Properties: Paste the copied media properties to another media.

 Locate Media: Locate the current media file in the media library.

 Delete Media: Delete the selected media.

Program Media Properties

Step 1 Select the desired media in a program.

Step 2 Select the Properties tab on the right pane of the user interface to show the media property settings.

XI'
AN
 N
OV
AS
TA
R T
EC
H 
CO
., L
TD
.



Kompass RX6 Video Playback and
Control Software User Manual

www.novastar.tech 39

Figure 4-33 Media properties

Table 4-6 Media property descriptions

Function Description

Name View or change the media name.

Duration View the length of the media playing time.

Start Time Set the start time of the media playback.

End Time Set the end time of the media playback. The time length from the start to end cannot be
greater than the media duration.

Delay Set the time length after which the media starts to play. When the program starts, the
delayed media will start to play after the delay time ends.

Playback Set the playback mode of the current media during the playing time of the program.

 Loop: loop the playback of the selected media in the program, and then will be
displayed at the top right of the layer in the Plan area.

 EOF: The current media will stop the playing and display the last frame after being

played once, and will be displayed at the top right of the layer in the Plan area.

 Stop: The playback will stop after being played once, and will be displayed at
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Function Description
the top right of the layer in the Plan area.

 Loop Times: Set the loop playback times of the current media, and is displayed
at the top right of the layer in the Plan area. (“N” stands for the number of loop times).

Jump Set the jump playback mode of the current media after the media playback ends.
 No Jump: No operation will be performed after the current media playback ends.
 Next Program: Jump to the next program after the current media playback ends.
 If you have enabled the program jump, the group name and program name of the
next program are displayed.

Switching Set the transition effect for switching the current media in the program layer.

Filling Set how the image is displayed in the selected layer.
 Fill: The image fills the layer.
 Proportional: The image is scaled and displayed in the layer according to its original
aspect ratio.

Flip Set the display mode of the output image. If H and V are not selected, the output image
is displayed normally, without any flipping effect.
 H: Flip the image horizontally.
 V: Flip the image vertically.

Bright Set the overall brightness of the layer image. The value range is 0%–100%, and it
defaults to 50%.

Contrast Set the overall contrast of the layer image. The value range is 0%–100%, and it defaults
to 50%.

Opacity Set the transparency of the output image. The value range is 0% (totally transparent)–
100% (opaque), and it defaults to 100%.

Hue Set the relative degree of how bright or dark the output image is. The value range is
0%–100%, and it defaults to 50%.

Saturation Adjust the colorfulness of the output image. The value range is 0%–100%, and it
defaults to 50%.

Feathering Adjust the blurring degree of the layer image edges. The value range is 0% (not
blurred)–100% (totally blurred), and it defaults to 0%.

Volume Set the volume for the media playback.

Crop  Cropping method:
− Crop: Crop the output image.
− Stretch: The media adapts to and fills the layer.

 Percentage:
− Selected: The unit for the cropping is the percentage.
− Deselected: The unit for the cropping is the pixel.

T: Set the size of the cropped area at the top part of the media.

B: Set the size of the cropped area at the bottom part of the media.

L: Set the size of the cropped area at the left part of the media.

R: Set the size of the cropped area at the right part of the media.

4.5.4 Set Program Jump

After the program editing is completed, set the program jump to realize the automatic continuous playback of
the programs.
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Before the program jump settings, you need to specify a media in each program as the timing base. After the
playback of the selected media ends, the specified program will start to play.

Step 1 Select the desired media in a program in the Plan area and right click the media to open the context menu.

Step 2 Select Jump to Specified Program and all the programs become selectable.

Figure 4-34 Program jump

Step 3 Select the desired program to complete the jump settings.

If you want to jump to a program in another group, click the name of the group where the program belongs,
and then click the program name to complete the program jump between program groups.

Step 4 Repeat Step 1 to Step 3 to complete the jump settings for more programs.

After the program jump settings, is displayed at the top right of the layer in the Plan area.

Note

When two programs become jump partners for each other, they will be played circularly.

4.5.5 Manage Program Groups

When you need a large number of programs, you can create groups to manage those programs. Each group
supports 20 programs by default.

Step 1 Click + at the bottom left in the Plan area to add a program group.

Figure 4-35 Add program groups

Step 2 Right click the group name and select Rename to give the group a new name.
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Figure 4-36 Rename groups

Step 3 Click + at the top right to add new programs to the newly-added group.

Figure 4-37 Add programs

4.6 Playback Control

After the program editing, you can play the programs.

 Program playback: Click next to a program name in the Plan area to play the program.

During the playback of a program, you can also switch the playback content of a layer. For example, in the
below figure, when Program 1 is being played, double click the media in Layer B of Program 2 to switch
the playback of the media.

Figure 4-38 Playback control-1

 Playback control: In the playback control area, control the playback of a single media or all the media.

Figure 4-39 Playback control-2

− Click or next to to play and pause the playback of all media in a program.

− Click or next to a media name to play or pause the playback of the selected media.

− Click at the top right, and the program media adopts the count up timer.
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− Click at the top right, and the program media adopts the countdown timer.

 Synchronous playback: Hold down the CTRL key, click the media to be played synchronously and drag the
media playback progress bar to play two media synchronously.

 Take to screen: In the Preview area, click Cut or Keep to send the preview program to the screen.

Figure 4-40 Preview playback

− Cut: Send the currently previewed program to the screen and play it from the beginning.

− Keep: Send the currently previewed program to the screen and start playing from the current progress
in the preview area.

 FTB

− Click at the top left of the main interface, and the output image will fade to black within the time
you set later.

− Drag the slider next to to control the FTB of the output image manually.

4.7 Save Projects

You can save the editing and settings as an independent project file for easy use in the future.

 Go to File > Save or Save As to save the current project file (*.prx6) to your local storage.

 Click at the top left of the main interface to save the current project.

 Click at the top left of the main interface to save the current project as a new project file.

 Click at the top left of the main interface to package the current project, such as all the used media or
all the media files and project files, which is convenient for future use.

XI'
AN
 N
OV
AS
TA
R T
EC
H 
CO
., L
TD
.



Kompass RX6 Video Playback and
Control Software User Manual

www.novastar.tech 44

5 Settings

5.1 System Settings

Set the startup-related settings. Go to Settings > System Settings to open the System Settings window.

Figure 5-1 System settings

 Name program after firstly-added media

− Selected: The program is named after the firstly-added media.

− Deselected: The program remains unchanged and keeps its default name.

 Lower image quality when bad performance

− Selected: When the computer performance does not meet the requirements of the playback, the
output image quality will be automatically lowered to ensure the smoothness of the image playback.

− Deselected: When the computer performance does not meet the requirements of the playback, the
output image quality will not be lowered, but the smoothness of the image playback may be affected.

 Pause media playback when black screen

− Selected: Stop the playback of the current media when the FTB function is enabled.

− Deselected: Do not stop the playback of the current media when the FTB function is enabled.

 Light up screen if play media when black screen

− Selected: When the screen is black, if you manually start the media playback, the FTB function will be
automatically turned off and the media will continue to play.

− Deselected: When the screen is black, if you manually start the media playback, the FTB function will
not be turned off and the screen will still display black.

 Play recent media after project opened

− Selected: When you open a project, the most recently played media will be played.

− Deselected: When you open a project, no media will be played and the project interface will be
displayed.

 Auto save project when no operation

− Selected: When you perform no operations on the current project, the project will be automatically
saved.
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− Deselected: When you perform no operations on the current project, the project will not be
automatically saved.

 Enable drop-frame rendering

− Selected: Enable the drop-frame rendering function.

− Deselected: Disable the drop-frame rendering function.

 Start software after power on

− Selected: Kompass RX6 will be started automatically after the system powers on.

− Deselected: Kompass RX6 will not automatically start after the system powers on.

 Start software and open recent project after power on

− Selected: The recently-opened project will be opened when Kompass RX6 starts.

− Deselected: No project will be opened when Kompass RX6 starts.

 Default fade duration: When you have set the fade transition effect for the program, you can set the fade
effect duration here. The value ranges from 0.1s to 10.0s and defaults to 0.5s.

 Preview quality: Set the image quality in the preview area.

− Original: The preview image quality is consistent with that of the input source image.

− Reduce: The frame rate of the preview image will be automatically reduced.

 Output Frame Rate: Set the frame rate of the output image.

After the settings are done, click OK.

5.2 Authorization

One authorization dongle corresponds to only one authorization file. When the dongle matches the
authorization file, Kompass RX6 can be used normally.
Kompass RX6 supports the centralized management of multiple authorization files. When an authorization
dongle is inserted, the system can automatically identify the corresponding authorization file to ensure the
normal operation of Kompass RX6.

Step 1 Import the authorization file.

1. Go to Settings > Authorization to open the authorization settings window.

2. Click Import at the bottom to open the authorization file importing window.

3. Select the desired authorization file and click Open. The system will automatically import the file to
Kompass RX6.

Figure 5-2 Authorization file

Step 2 Check the authorization.

1. Insert the authorization dongle into the system.

2. The system will automatically identify the authorization file according to inserted the authorization dongle,
and then display In Use after successful identification.
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5.3 Hotkey Binding
Kompass RX6 supports custom hotkeys, and users can use those keys to operate Kompass RX6 simply and
conveniently. Go to Settings > Hotkey Binding to show the hotkey settings interface, and the areas where
you can enable the hotkey function are highlighted.

Figure 5-3 Hotkey binding

Click the target area, and then press the letter or number keys on the keyboard as needed to complete adding
the hotkey.
After the adding, go to Settings > Complete Binding to make the hotkeys take effect and exit the hotkey
settings interface.
For example:
Set the hotkey for Program 1 to Q.
1. On the hotkey settings interface, click Program 1.
2. Press the letter Q on the keyboard, and then a letter Q will be displayed on Program 1.
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6 Help

6.1 User Manual

Go to Help > User Manual on the menu bar to open and view the product user manual.

6.2 About

View the software version, license agreement and other information, and scan the QR code to get more
information on NovaStar products or send us your feedback.

6.3 Software Updates

Check the current version of the software. When a new software version is detected, the system will download
the latest version and then you can follow the instructions to complete the update.

6.4 Contact Us

View the contact information of the software provider and the software copyright and license agreement.
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